PanelMate ePro PS Classic
Application Note

for new RoHS ePro PS Classic models
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Agenda

Overview of PanelMate ePro PS
What is “Protect Mode Save” and why is it important

«  How Kepware works for PLC communications
« How ePro PS starts up and launches the application

« Step by Step process for converting an application and
loading an ePro PS Classic

Troubleshooting communications and startup problems.

 Reloading a unit to original factory settings (for
catastrophic recovery)
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PanelMate ePro Protect Mode
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PanelMate® ePro PS
Enhanced Protect Mode — A Unique Advantage

AT

Exclusive Protect Mode Capability

Eliminating these issues
reduces installation and
maintenance costs and
eliminates process
downtimel!

Always enabled

Completely protects entire operating system,
system settings, and programs from
modification

Eliminates common headaches from use of
Microsoft based PC platforms in industrial
applications:

« Corruption from unplanned power loss

« Corruption from virus or worm attacks

* Poor performance from fragmented disk files

* Unwanted or unexpected software changes

* Problems from unwanted cookies, temporary
files, automatic installation of ActiveX controls,
etc.
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PanelMate® ePro PS
Enhanced Protect Mode — A Unique Advantage

* Protect Mode - How does it work?

« At the operating system level any process
which attempts to write to the Windows drive
(C:\) is actually re-directed to volatile RAM
memory

« The operating system “fools” the application or
process, making it appear as if the write has
taken place

* Once the system re-boots or goes through a
power cycle, RAM is cleared and the system is
left unchanged
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PanelMate® ePro PS
Enhanced Protect Mode — A Unique Advantage

Protect Mode - How do | install software or
make changes to the Windows drive, such as
touchscreen calibration settings, IP address,
time, or installing a 3™ party software package
such as UltraVNC?

- After a fresh reboot, make the changes as you would
normally do on a standard Windows PC

- Before re-booting the ePro PS, run the “Protect Mode
Save” utility (Start > Programs > ePro Manager —
select Protect Mode Save tab — click on “Commit”)

* Once you click OK on the Commit button the system
will go through a shutdown sequence during which
time the system writes all pending changes from
RAM to the C:\ drive, then reboots

« After the reboot the system is again automatically
running in Protect Mode
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PanelMate® ePro PS
Enhanced Protect Mode — A Unique Advantage

Protect Mode - What do | do if | somehow corrupt
the Windows C:\ drive (through loss of power during
a Protect Mode Save operation or if | cannot
remove “bad” software | saved). Can | restore the
ePro unit to original factory settings?

« Restore Kits are available for you to purchase that
include a CompactFlash module which has the
original OS image of the internal drive and USB flash
drive with a Linux operating system and restore utility.
The kit comes with step by step instructions for doing
a restore of the ePro

* You'll need a USB keyboard and mouse to perform
the restore operation and you’ll be able to completely
restore the unit in less than 15 minutes
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KEPServer_ePro OPC Communications
Overview
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The History of OPC

*  OPC (OLE (ovject Linking & Embeading fOr Process and Control)

- Started in 1995 by a group of vendors forming what is now known as the
OPC Foundation

» Goal of developing a single client/server specification that would allow any
vendor to develop software and applications that could share data in a fast,
robust fashion

« The first specification, called Data Access Specification 1.0a -- released in
early 1996 -- established a set of standard OLE/COM interface protocols
(intending to foster greater interoperability between automation/control
applications, field systems/devices, and business/office applications in the
process control industry)

« A major goal of the OPC Foundation and the Data Access specification was
to eliminate the need of client application vendors to develop their own
proprietary set of communications drivers.

* Nearly 400 members from around the world
- www.opcfoundation.org
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What is OPC?

 Fundamentally it is a way for two programs to
exchange information/data

 One program is a client the other program is a
server

* The client only needs to “speak” OPC-ese

 The server needs to speak the native protocol of
the communicating device (i.e. PLC) as well as
OPC-ese

Powered by I‘ATS



How Does OPC Work?

Coment allez
vous?

His names Jack
What’s your OPC

) Server /
name OPC

Client PLC (Proprietary Je m’appele

Protocol) Jaques
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How Does OPC Work?

’ Coment allez Je m’appele
What S your What’s your vous? Ja 5 eps
name? name? His names Jack q

N= Nl

N Remote OPC Local OPC J eV pLe
Client Client Proprietary

rotocol)
Ethernet (DCOM)

New York Office : :
Paris Office

Powered by B ATS



KEPServer ePro Terminology

* A Channel represents a channel of
communication which defines:
- Communications Protocol to use
« Communications “port” to use
- Communications settings

* A Device represents the PLC which
communicates on the Channel and defines
« Address of device
- Comm. error reporting parameters
 Avallable tags or addresses
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KEPServer ePro Terminology

A Tag or Address is defined as:
 ChannelName.DeviceName. XXXXX

* An Access Path can be used to shorten the tag
name:

 In above example if you define the Access Path to be
ChannelName.DeviceName then the tag is just
XXXXX
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Kepware Server Configuration

< KEPServerEx - [untitled.opf]

Tools Help

=10l x|

6 Steps and running! | ==
« Start the Server o
* Create a channel

* Create a Device e

« Add Tags

« Save the project

* Launch OPC Quick Client

DeHPMasE]o b BexX|&

nel.

| Address

| Data Type.

I DDE Scan Rate | Scalint

annel - Summary

If the following information is correct click 'Finish' to
zave the settings for the new channel.

Dest

Mame: E1
Device Driver:
Diagnostics: Ei

Metwork Adapl
Default

Write Optimizal
arite all value:
10 writes per re

< Back I

New Device - Summa

IF the following settings are comect click Finish' to begin
usging the new device.

MName: D1
Model: Terminator /0
1D: 192.168.111.2M

-

Connect Timeout: 3 Sec.
Request Timeout; 1000 ms
Fail after 3 attempts

Tag databaze startup: Do not generate on startup
Tag databaze action: Delete on create
Create tags in: D1

Link ‘' atchdog: Disabled

<* KEPServerEx - [untitled.opf *] o Dll]
File Edit Yiew Users Tools Help
DEE @il OoE « & BI
Eef LUl < Back I Finish I Cancel | Help | =
= inifo1 HAEBC_SP0_E
[ 5L0T_0 HEBC_5P0_L =
[ sloT oz ¢ JEBC_SPO_DATAIN_STRING EBC:SPO.DA...  String 100 Mone Data bytes received from serial p.
(] SLOT_03 ¢ JEBC_SPO_DATAIN_EYTEARRAY EBC:SPO.DA... Byte 100 Mone Data bytes received from serial p.
-] SLOT_D4 ¢_JEBC_SPO_DATAIN_CHARARRAY  EBC:SPO.DA... Char 100 MNone Data bytes received from serial p,
e HFR™ SDN NMATAMIT STOTRIC FR™SDN MiA Shrinn inn LAY Maka cank ko carial navk's TY Ao,
[]sLoT_os z I" R
Date | Time: I User Name | Source I Ewvent |
o 6/14/2002 10:32:49 Default User KEPServerEx AutomationDirect EBC device driver loaded successfully.
€ 6j14/2002 10:35:55 Default User KEPServerEx Starting AutomationDirect EBC device driver,
o 6/14/2002 10:35:55 Default User AutomationDirect EBC AutomationDirect EBC Device Driver ¥4.30,37 - U
€ 6j14/2002 10:44:39 Default User KEPServerEx Attempting to automatically generate tags for device 'E1.D1".
o 6/14/2002 10:44:40 Default User KEPServerEx Completed automatic tag generation For device 'E1.D1"
Ready |Clients: 0 |active tags: 0cf 0 4
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Addressing differences between
KEPServer ePro & Power Pro

* For SLC 500 applications, if you are referencing local /O addresses
you must fill out the 1/0O Slot configuration for the PLC in the Device
properties.

« For SLC 500 serial (DF1) driver PanelMate always used BCC error
checking. With KEPServer_ePro you choose between BCC and
CRC.

« |If using non default data types that required casting operators in
PanelMate (Eg. Modicon Floating Point values with #FP, any String
values with #ASC20, etc.) you must create a tag in KEPServer_ePro
to represent the address and assign the correct data type to the tag.
Then change PanelMate’s address to refer to the KEPServer _ePro

tag (Eg. [plc1,tag])

« Remember, KEPServer ePro’s address syntax overrules Power Pro
syntax — most drivers are identical, but if in doubt refer to
KEPServer _ePro’s driver help files to make sure.
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PanelMate Client Configurat

ion

PLC Mame and Port Table

Port Parameters

|

Port Device Use Local ID
In PLC Name & Port Table 2 No Usage _ |
1/0 (Unequipped - Ho inter Face board) |
select OPC Server for any e e
port (it doesn’t matter which [0PC Server = |

PLC Hame Parameters

one)

Item Mame Port Model Remote Tag File Path & Hame
Add a PLC to that port 2:"New entry > ’

Click on OPC Setup to assign
the server name and Access

Change

Copy

Delete

aialos

Path Name to the PLC Name: [ploT  Modek |

~||[CoPC Setup ]

Tag File...

Default
PLC Name:

Port: |1 ﬂ Remote ID: |0

| ok

Optionally, click on Tag File
... and browse for the tag file
exported from Kepware and
select the tag and address
columns

| | Cancel | | Help |

=L

@ Notepad

Tag Mame File For Device: plc1

Current Selected Tag Mame File:
[C:\CANVAS~1\PROJEC-1\SLC505-1.C | Open... | [ New... || Edit... |

) Excel
Reference Column:
| 1: Tag Mame

J | 2: Address ﬁ
Linedt: [Select the Tag Start Line)

1:Tag Hame Address,Data Type Respect Data Type.Client Access,Scan Hale:

Tag Name Column:

L+

plcl

OPC Server Setup For Device: plc1

Server Name:

|EalnnEIectricaI.KEP5 erver_ePrd

Access Path Name:

|.¢\BE.SL[Z

I | Lancel | ‘ Help

2

2:Cycle_Time T4:0 ACC Word, 1. RAW.100..........
3:Cycle_Time_Reszet, T4:0 PRE Word, 1. RAW 100,_.......
4:Machine_Speed N7:2 Word, 1. R/ 10..........
H:Messagel S5T20:0 5tning, 1 R/ 100 .....
6:Mold_Gap_5etN7:0. Word,1.R™Aw 100..........
#:Motorl_reqS5tart.B3/0, Boolean, 1. R/W 100, ... ......
8:Motorl_reqStop.B3/1,Boolean, 1. R/ 100..........
9:Motorl_Status B3/2 Boolean, 1. RAW.100..........
10:Motor2_reqStart,B3/3 Boolean, 1 RAW 100,.........

0K | | Cancel | |
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Hdw ePro PS starts up and launches
the application
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How Does ePro Start Up the
PanelMate Application

* At boot up the file PMStart.cmd executes
« Located in D:\
* Runs PPS file referenced as MyCfg =
* When PPS file launches it will launch the OPC server

- -
v TI—
' PMStart.cmd - Notepad E]@
File Edit Format wiew Help
Becho off -
REM * To set this batch file to automatically start a r
REM * Panelmate PC Pro Application, set the wariable 3
REM * My_CFE To tThe desired pathfilename.
set My_CFG=d:“wcfo \Dvdemo. pps
REM * If wou are going to start Document viewar,

REM * Headline Manager, or Trend viewer after the
REM * PanelMate configuration loads, set the garwab'le
REM * CFE_LOAD_TIME to the number of seconds it takes
REM * to completely boot up the PPs file. Measured from
REM * when begins to Toad until the first display 1= drawn
REM * following a power down reboot.

v
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How Does ePro Start Up the
PanelMate Application

* At boot up the file PMStart.cmd executes
* Located in D:\
* Runs PPS file referenced as MyCfg =

 When PPS file launches it will launch the
KEPServer ePro OPC server

- KEPServer_ePro will launch one of two .OPF
files (driver configuration files)
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How Does ePro Start Up the

PanelMate Application (cont.)

-,

uﬂpt'iuns .
. General |view | Service | Event Log | OPC Settings | OPC Compliance | OPC D | DDE
Kepware will launch one of _F.,Die,!t Fneae'mngg —— e e
tWO . O P F f| IeS (d rive r Default project iD:HEfg\erD emat/3.opf _J
CO nfl g U ratl O n fl IeS) keep track of the ! a vi mozt recently uzed project files,

W Always backup the last zaved project file prior to averwriting the file with new changes

C5Y delimiter I ; vi

* |f an OPF file is referenced in

“Tools>Options”, General tab, [T o
\ gk for confirmation when deleting an object.
Qefau It prOJeCt - then th at O P F W Ask for confirmation when an operation will cauze clients to be disconnected.
fl |e Wl ” run. W PFrompt to zave project changes.
—Exit ophions

Select the action vou want to take when the I'&'Sk to save [with timeout] ;l

° If no Qefault prOJeCt — then the ;nra;'reecrtfautnmatically ghuts down with a modified = I_I-D—j-J e
last opened OPF file will load

] I Cancel | Apply | Help |

* This setting is saved to the

ServerMain.ini file located in So, a Protect Mode Save
“C:\Program operation is required to save the
Files\KEPServer_ePro” name of the OPF file to open!
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Converting an application and loading
an ePro PS Classic
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PanelMate Power Pro Conversion

1. Import .PPS file to PanelMate Power Pro editor
(“File > Import”)
2. Convert the Model to PanelMate PC Pro (“File >
Convert”)
3. Convert communications setup from PLC Name
& Port Table to KEPServer _ePro
Convert PanelMate driver to OPC Server

4. Export to new .PPS file name (“File > Export)

Note: Do not use “File > Export As” which strips off
OPC configuration information from the file

Powered by I‘ATS



PanelMate Power Pro Conversion

5.

Load new .PPS and .OPF files to the ePro PS unit to
“D:\Cfg” directory

Edit D:\PMStart.cmd and point MyCfg = to the PPS file

Install KEPServer_ePro on the ePro PS unit, choose
Modify from Upgrade, Modify, Remove selection and
select the correct driver from the driver list to install.
(copy install CD to USB memory stick)

Open KEPServer_ePro and set the Default project to
the new OPF file.
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PanelMate Power Pro Conversion

9. Perform a Protect Mode Save operation

« “Start > Programs > ePro Manager — select Protect
Mode Save tab — click on “Commit”

10.Connect communications cable (need male -
female 9 pin adapter for serial cable)

11.Go on line, should be automatic after the
Protect Mode Save operation, and debug
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Troubleshooting communications and
startup problems

Powered by B ATS



Troubleshooting communications
and startup problems

« Symptom: No data is showing up and you are
not getting communications errors.

 Possible Causes

* The OPC Setup information was not entered correctly
in the PLC Name and Port Table

* Check that the OPC Server name is:
EatonElectrical. KEPServer _ePro
» Make sure the access path is spelled correctly

* The “Export As” function was used for the PPS file

generation instead of just “Export”. This strips out any
OPC setup entries.
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Troubleshooting communications
and startup problems

« Symptom: No data is showing up and you are
not getting communications errors (cont.)

 Possible Causes

« The OPC Server is not installed on the ePro PS unit or
the correct driver or drivers was not installed.

* The OPC Server has the wrong default project
selected

« Open KEPServer_ePro and verify that your OPF file will open
and that it is the default project

 Remember to do a Protect Mode Save if the default project is
changed or if a the OPC server or driver is updated or
installed
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Troubleshooting communications
and startup problems

- Symptom: No data is showing up and you are getting
communications errors.

« Possible Causes — Improper cable, port, or KEPServer_ePro setup

« Check KEPServer_ePro to verify you are using the correct serial port on the ePro
PS

» Make sure the cable pinouts are correct — see the KEPServer_ePro driver help
file for cable pinouts (may not be the same as the Power Pro with a male -2
female gender changer)

« Check KEPServer_ePro setup and verify all settings, then test with their OPC
Quick Client and verify that data quality is good for the PLC’s access path
(_System paths will always show good data). If no tags are configured create
tags in the Quick Client to read known good addresses. If KEPServer_ePro’s
Quick Client cannot read data from the PLC neither will PanelMate
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Troubleshooting communications
and startup problems

* Symptom: Some data is showing up but you are getting
communications errors on some of the addresses

* Possible Causes — Improper Slot configuration or non-
default data format casting operators (#FP, #ASC, etc)
are not understood by KEPServer_ePro

If you are trying to read local I/O in an AB SLC or PLC-5 you need to
correctly set up the Slot Configuration tab of the device properties in
KEPServer_ePro

PanelMate formats for non-default data types are not understood by the
KEPServer _ePro driver. You should create tags in KEPServer _ePro for
these addresses and define the data type in the tag, then use the tag
instead of the address inside of the square brackets in PanelMate (Eg.
[PLC1, tagname] )

Powered by B ATS



Troubleshooting communications
and startup problems

« Symptom: The demo application or some other
application is starting instead of the one you want, or no
application starts and it boots into the ePro’s desktop

* Possible Causes — The PMStart.cmd file isn’'t configured
to run the correct PPS file or you copied the wrong PPS
file to the ePro, or the PMStart.cmd file was deleted

- Edit the PMStart.cmd file on the D:\ drive and verify that MyCfg =
is set to the correct file name

« Copy the PPS file back to your PC and import it into the
PanelMate editor to see if you have the correct file on the ePro
unit.

 If the PMStart.cmd file does not exist you must reload it

Powered by B ATS



Troubleshooting communications
and startup problems

« Symptom: The ePro PS unit does not boot up to Windows

« Possible Causes:
« The power supply is insufficient for the ePro PS (white or black
screen)

* The 8" requires 1.3 amps, the 10” 1.35 amps, the 12" 1.5 amps and
the 157 2.0 amps

« Peak inrush is 7.0 amps for all except the 15" which is 8.0 amps
* The Operating System has become corrupted

» Losing power during a Protect Mode Save or performing a Protect
Mode Save after installing bad software or being exposed to a virus or
other malware could corrupt the OS. If this happens a “Restore to
Factory Image” needs to be done.
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Troubleshooting communications
and startup problems

« Symptom: The ePro PS unit does not boot up to Windows
(cont.)

 Possible Causes:

* A device is installed in a PCMCIA, external CompactFlash driver or USB
drive that is affecting proper startup. Remove all devices and try re-
booting

» The display or backlight has failed so that you can'’t see that it is running
properly. Hook up an external monitor to ePro’s VGA port to verify. If the
display or backlight has failed, contact Eaton Electrical’s service and repair
department at (877) ETN-CARE (Backlights are field replaceable with the
proper kit from service)

* A hardware failure requires the unit be repaired. Contact Eaton
Electrical's service and repair department at (877) ETN-CARE
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Reloading a unit to original factory
settings (for catastrophic recovery)
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Reloading a unit to original factory
settings

* Equipment Required:
« USB Keyboard and Mouse

» Factory Image Restore Kit

« Cat# 76MLPS - Includes restore image on a CompactFlash
module, a USB flash drive with Linux operating system and
restore utility, and IL (Instruction Leaflet) with detailed step by
step instructions for restoring the ePro PS internal operating
system drive.
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Reloading a unit to original factory
settings

* Process Overview (excerpted from IL)
1. Remove power from the ePro PS unit

2. Install CompactFlash restore module to external CF
socket (Make sure of correct orientation, don’t force
insertion! )

3. Connect USB mouse and keyboard to USB ports
4. Restore Power and when boot up.

5. Once Linux loads from the USB drive (about 1
minute) you will be prompted to press “Y” on the
keyboard to start the restore process.
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Reloading a unit to original factory
settings

*  Process Overview (excerpted from IL)

6. When the utility has finished restoring the internal drive you will
be prompted to remove power and remove the Factory Image
Compact Flash drive and USB flash drive

7. Wait approximately 8-9 minutes to perform first-boot agent
function, then when prompted click OK on the Netware Logon
dialog.

8. When the ePro XPe Configuration dialog comes up, use the
drop list to select the proper ePro PS Classic model then click
on “Apply Model”

9. After all model changes have been made (approx. 1 minute) the
“Save” button will go from a greyed out state to black. Click on
the “Save” button. The system will then reboot.
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Reloading a unit to original factory
settings

* Process Overview (excerpted from IL)

10. Go to Start > Programs > ePro Manager —
Touchscreen tab, and click on “Calibrate
Touchscreen”

11. On the Penmount Control Panel click on the
Calibrate tab then click on the standard calibration
button to start the touchscreen calibration process.
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Reloading a unit to original factory
settings

*  Process Overview (excerpted from IL)

12. Go to the system tray and double-click on the clock.
Change the time zone settings to the correct time-
zone and set the time and date.

13. Go to the system tray and double-click on the screen
saver icon. & Adjust the number of seconds for the
screen saver to kick in and set the brightness for the
screen saver to prolong the backlight life.

14. Do a Protect Mode Save

Start > Programs > ePro Manager — select Protect Mode Save
tab — click on “ Commit ”
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Questions?

e-Mail:
Call: (800) 328-7287
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